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The Kodak i4000 Plus Series Scanners provide the ability to process
scanned images to improve their quality by using image processing
features.

Image processing refers to features of the scanner that allow you to
automatically adjust each image that may improve the resulting images
(i.e., correcting any skew in the fed document, cutting the edges of the
image off to remove unneeded borders or cleaning up extraneous
“noise” on the image).

The ISIS Driver is software that communicates with the scanner. This
driver is created and maintained by EMC Captiva and is provided with
the scanner by Kodak. This driver can be used to interface with many
scanning applications that support ISIS drivers.

The information in this guide provides descriptions of the features on
the tabs of the ISIS Driver windows. The same features should be
available on the user interface of the scanning application you are
using.
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Starting the Scan NOTE: The Scan Validation Tool is provided by Kodak and is a

Validation Tool diagnostic tool only. Kodak does not support the use of the Scan
Validation Tool as a scanning application.

1. Select Start>Programs>Kodak>Document Imaging>Scan
Validation Tool.

£ Scan Yalidation Tool x|

Drriver Types:

Dirivers
EQDAE 200

2. Select ISIS for the Driver Type and the KODAK i4200 (i4600) as the
driver and click OK.

3. Click the icon to enable the image view panels.

4. Click the Setup icon on the main Scan Validation Tool screen.

=10 %]

' Scan ¥alidation Tool - ISIS

Dizplay Eveny: |1_
Total: Last File: I
| |
The Setup dialog box will be displayed.
setup x|

— Compression

Front Colar:

JPEG
Front Bitonal:

Group-4

Frear Eolor: [none]
JFEG

Frear Bitonal: [none]
Group-4

2 A-61654/I1SIS August 2013




5. Click ISIS. The Preset Configurations dialog box will be displayed.
This dialog box maintains a list of saved driver settings.

You can save, delete or import a preset; or select a preset that is
already set up or one you want to modify.

KODAK i4200 on None

— Preset Configurations
=1
Freset Mame:

| [ efault

D escription:
Default zettings. d
— Propertiez
Image... Scanmer... |
oK I Cancel |

6. Click Image to configure settings associated with the image.

The following sections provide descriptions and procedures for
configuring Image settings. See the section later in this chapter

entitled, “Configuring Scanner settings” for scanner configuration
procedures.
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Configuring Image
settings

The main ISIS Driver window provides a set of several tabs for
configuring images. You can select each of these tabs and make any
choices necessary to meet your scanning needs.

NOTE: The Image Mode, Camera, Mode and Toggle Patch selections
are available with all of the Image tabs (i.e., Main, Layout,
Image Processing, etc.).

x
Preset: |iDetauiti2]
~Image Made h.‘?c!iustments I Image Edge Fill I Blank Image Detection I About I
INormaI j an | Layout I Image Processing I Auto Color Detect I Drropout
Camera: Dotz per inch:
FrortImage i1 N - |
[ Front Image #2 ]
[ Back Image #1 Cropping:
[ Back Image #2 IFixed Ta Transport j
Binarization:
iThreshalding -
Mode: I J
Black and ‘white = Threshald
Grayzcale 1 =
Color / ID |
Auto Detect Grapscale ! !
Auto Detect Color 0 255
r— Contrast
1
— 0 F 3
Toggle Patch: B0 50
oif |

Copy | QK I Cancel | Help Drefault

Image mode — select one of the following options:

* Normal — typically, for a document, one image is created for the
front side and another image is created for the back side. Select this
option if you want the front and back side to be individual images.

» Merged — select this option if you want one image that contains both
the front side and back side of the document. Image Merge options
are:

- Front on Top; Front on Bottom; Front on Left or Front on Right.

Camera — the selections in the Camera box list the available sides
(front and back) of an image where you can define individual image
processing values. Options include: Front Image #1, Front Image #2,
Back Image #1 and Back Image #2.

The Kodak Scanner drivers allow you to control the camera settings
independently. Some settings apply only to black and white images,
others apply to color/grayscale images.
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Mode — select one of the following modes:

» Black and White: if you want your electronic image to represent all
elements of your document in black and white.

» Grayscale: if you want your electronic image to have a range of
varying shades of gray from black to white.

» Color: if you want your electronic image to be in color.

» Auto Detect Grayscale: sets auto color detect for grayscale. See
the section entitled, “Auto Color Detect tab” for more information.

» Auto Detect Color: sets auto color detect for color. See the section
entitled, “Auto Color Detect tab” for more information.

Toggle Patch — indicates you want to tell the scanner, via a toggle

patch document, if the document is color/grayscale or black and white.

» Off: no patches will be used.

» Same Side: only the side which recognizes the patch sheet will
toggle.

» Both Sides: a patch will be recognized on either the front or the back
side.

Buttons — the buttons on the bottom of the window apply to all tabs:

» Default — resets the values on all tabs to the factory defaults.

» Copy — this function is only available when scanning two-sided
documents. The Copy button provides a convenient way to set up the
color, grayscale or black and white image settings on one side and
transfer them to the other. For example, if you highlight and set up
Front Image #1, you can use the Copy button to duplicate those
settings for Back Image #1.

» OK — saves the values set on all tabs.
» Cancel — closes the window without saving any changes.

» Help — displays on-line help about the options available on the
selected window.
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Main tab The Main tab provides the following options:

x
Preset: |iDetauiti2]
~Image Made h.‘?c!iustments I Image Edge Fill I Blank Image Detection I About I
INormaI j an | Layout I Image Processing I Auto Color Detect I Drropout
Camera: Dotz per inch:
FrortImage i1 N - |
[ Front Image #2 ]
[ Back Image #1 Cropping:
[ Back Image #2 IFixed Ta Transport j
Binarization:
iThreshalding -
Mode: I J
Black and ‘white = Threshald
Grayzcale 1 =
Color / ID |
Auto Detect Grapscale ! !
Auto Detect Color 0 255
r— Contrast
1
— 0 F 3
Toggle Patch: B0 50
oif |

Copy | QK I Cancel | Help | Drefault |

Dots per inch (dpi) or resolution — indicates the scanning resolution,
which largely determines the quality of the scanned image. The greater
the resolution, the better the reproduction. However, scanning at a
higher resolution also increases scanning time and file size.

Select a resolution value from the drop-down list. The default is 200 dpi.
Available resolutions are: 100, 150, 200, 240, 300, 400 and 600 dpi.

Cropping — allows you to capture a portion of the document being
scanned. All cropping options can be used with color/grayscale and
black and white images. Front and Back cropping are independent,
however, for dual stream scanning, color/grayscale and black and white
cropping must be the same per side. Only one cropping option can be
assigned per image.

» Automatic: dynamically adjusts the cropping window for different
document sizes based on the edges of the image.

» Aggressive: eliminates any residual black border on any image
edges. In order to achieve this, there is a possibility that a small
amount of image data from the edge of the document may be lost.

» Fixed to Transport: (used for batches of same-sized documents)
allows you to define the area to be imaged. Fixed to Transport
cropping is used in conjunction with paper size and page layout and
assumes you are center-feeding your documents. If you are not using
center feeding, you must select the Layout tab to define your scan
area. See the section entitled, “Layout tab” later in this guide.
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» Relative to Document: (zone processing): (used for batches of
same-sized documents) — zone processing is a floating fixed crop
window (the zone) located relative to the upper left corner of a
document. It allows you to select an area on the document to be
delivered in either color/grayscale or black and white format (a
separate window for both black and white and color/grayscale may
be defined). Different parameters may be selected for both the front
and back of the image.

This option may be used in conjunction with Automatic cropping
where a separate color/grayscale or black and white area to be
saved is desired. It is useful in applications where a photograph,
signature, embossment or seal appears in a consistent area for an
application (you may want that small area in color/grayscale and the
rest in black and white). To define a zone, select the Layout tab.

» Photo: the scanner will locate the photograph on the document and
return an image that contains just the photograph. If the scanner
finds more than one photograph on a document, one image is still
returned. If no photo is found, the entire document is returned. The
entire document is used to locate the photograph.

* Photo w/ROI (Region of Interest): this option is the same as Photo
(above) except that only a portion of the document (which is specified
on the Scan Area dialog box) will be used to locate the photograph.

Binarization — these options work on grayscale images and outputs a
black and white electronic image. Their strength lies in the ability to
separate the foreground information from the background information
even when the background color or shading varies, and the foreground
information varies in color quality and darkness. Different types of
documents may be scanned using the same image processing
parameters and results in excellent scanned images.

e iThresholding: allows the scanner to dynamically evaluate each
document to determine the optimal threshold value to produce the
highest quality image. This allows scanning of mixed document sets
with varying quality (i.e., faint text, shaded backgrounds, color
backgrounds) to be scanned using a single setting thus reducing the
need for document sorting. When using iThresholding, only Contrast
can be adjusted.

» Fixed Processing (FP): used for black and white and other high
contrast documents. If Fixed Processing is selected, only Brightness
can be adjusted.

» Adaptive Thresholding (ATP): separates the foreground
information in an image (i.e., text, graphics, lines, etc.) from the
background information (i.e., white or non-white paper background).
When using Adaptive Thresholding, Brightness and Contrast can be
adjusted. Use this option when scanning similar type documents.
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Threshold (Brightness) — this option is available when you select
Fixed Processing or Adaptive Thresholding (ATP). This option
allows you to change the black and white image to be darker or lighter.
The higher the threshold value, the darker the image. Use the slider to
select a value from 0 to 255. The default is 90.

T _ N L ] — R
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[ |
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I ‘

Threshold: 50 Threshold: 127
Contrast — adjusts how much of the faint detail you want to see in the
output image. The higher the contrast value, the more faint lines will be
shown in the image. The lower the contrast value, the clearer (or less
detailed) the output image will be. If contrast is set too high, you may
get lines or black areas in your output image that you do not want. If the
contrast is set too low, some letters or lines may not show in the output
image. Select a contrast value from -50 to 50. The default is 50.

8 A-61654/I1SIS August 2013




Layout tab The Layout tab provides the following options:

Page Size — the default page size is set when a scanner is first
selected. You can choose a different page size using the drop-down list.
Page size should be set to the Scanner’s maximum when using the
Automatic, Aggressive or Photo cropping option.

Image Orientation

» Portrait: displays the image orientation in the shape of a
conventional portrait, where height is greater than width.

» Landscape: displays the image orientation in the shape of a
conventional landscape painting, where width is greater than height.

» Automatic: the scanner will analyze each document to determine
how it was fed and will rotate the image to the proper orientation.

Page Orientation — allows you to select the way you place your
documents in the scanner, Top edge first, Bottom edge first, Left
edge first or Right edge first.

Scan Area — displays the Scan Area dialog box. The Scan Area
options are only available for images when the cropping option is Fixed
to Transport or Relative to Document. See the next section entitled,
“The Scan Area dialog box” for more information.

1
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Scan Area dialog box

The Scan Area dialog box allows you to define the amount of image
data which is returned to the host.

NOTE: Select the Image Mode (either Normal or Merge) based on the
cropping option selected on the Main tab. If you select Normal,
select the side(s) (i.e., Front Image #1, Front Image #2, Back
Image #1 and/or Back Image #2) to be defined.

If you Select Merge, select the orientation of the merged images
(i.e., Front on Top, Front on Bottom, Front on Left or Front
on Right). The scan areas defined for all camera selections are
independent.

» Select Scan Area on the Layout tab to access the Scan Area dialog
box.

10
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NOTE: The Scan Area dialog box is only available when Fixed to
Transport, Relative to Document, or Photo with ROl is
selected on the Main tab.

x

Page Size:
Letter - 85511 in

— Page Layout
' Paotrait
" Landscape

rea

[v Snap

width: |8 1/2"

ﬂﬂ sl

Height; 11"

Units:

I Inches

()8 I Cancel |

Page Size — the default paper size is set when a scanner is first
selected. You can choose a different paper size using the drop-down
list.

NOTE: Page Size also appears on the Layout tab. If you make a
change on the Scan Area dialog box, the same selection
appears on the Layout tab and vice versa.

Page Layout

» Portrait: displays the image orientation in the shape of a
conventional portrait, where height is greater than width.

» Landscape: displays the image orientation in the shape of a
conventional landscape painting, where width is greater than height.

Area

* Snap — enable this option to control the dimensions of the preview
area to fixed 0.3175 cm (1/8-inch) increments. This option is not
available in Pixels mode.

» X: the distance from the left end of the scanner to the left-edge of the
scanning area.

* Y: the position from the top end of the document to the top end of the
scanning area.

» Width: the width of the scanning area.
» Height: the height of the scanning area.

Units — select whether you want the area to be defined in Pixels,
Inches or Centimeters.

1
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Image Processing tab The Image Processing tab provides the following options:

x
Preset: |iDetauiti2]
~Image Made Ac!iustments I Image Edge Fill | B_!::ank Image Detection I About I
INormaI j M ain I Layout | Auto Color Detect I Drropout
Camera: — General Options
Front Image #1 ]
[ Front Image #2 [ Halftane Removal
[ Back Image #1 O Invert Image
O Back Image #2 [ 4dd Border
[ Hole Fill
Mode: Document Type
Black and ‘white ITth with Graphics j
Grayscale )
Color Media Type
Auto Detect Grapscale . -
Auto Detect Color IF'Ialn Paper J
JPEG Huality
IBetter j
Moize Filker
Toggle Patch: | Lore Pixel |
oif |
r— Streak Filter
W on — [ 3
2 2

Copy | QK I Cancel Help Drefault

General Options

» Deskew — automatically straightens a document within +0.3
degrees of the leading edge of the document. Deskew can detect up
to a 45-degree skew and correct up to a 24-degree angle at 200 dpi
or a 10-degree skew angle at 300 dpi. This option is only available
when Automatic is selected.

NOTE: To prevent data loss, the document must have all four
corners within the image path.

» Halftone Removal — enhances images containing dot matrix text
and/or images with shaded or colored backgrounds using halftone
screens and effectively eliminates noise caused by the halftone
screen.

* Invert Image — allows you to select how the black pixels will be
stored in the image. By default the black pixels are stored as black
and the white pixels are stored as white. Turn this option on if you
want the black pixels stored as white and the white pixels stored as
black.

NOTE: You may want to change this option if your application
misinterprets the image data and stores your image in
reverse of what you expect.

» Add Border — allows you to add a fixed amount of border to the left,
right, top and bottom edge of the image. This option is not available
when Aggressive is selected.
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Hole Fill — allows you to fill in the holes that are around the edges of
your document. The types of holes that are filled include: round,
rectangular, and irregularly shaped (e.g., double-punched or those
having a slight tear that could have occurred when the document was
removed from a binder).

» Do not turn Hole Fill on if you are scanning photos.

Document Type
» Text: when the documents you want to scan contain mostly text.

» Text with Graphics: when the documents you want to scan contain a
mix of text, business graphics (bar graphs, pie charts, etc.) and line
art.

» Text with Photographs: when the documents you want to scan
contain a mix of text and photos.

* Photographs: when the documents you want to scan are comprised
mainly of photos.

Media type — allows you to select the type of paper you are scanning,
based upon the texture/weight. The options are: Plain Paper, Thin
Paper, Glossy Paper, Card Stock, and Magazine.

JPEG (Joint Photographic Editor Group) Quality — if you choose
JPEG compression, select one of the quality options:

 Draft: maximum compression which produces the smallest image
size.

» Good: a fair amount of compression but still produces acceptable
image quality.

» Better: some compression which produces decent image quality.

» Best: minimal compression which produces very good image quality.

e Superior: the least amount of compression which produces the
largest image size.

Noise Filter
e None

* Lone Pixel: reduces random noise by converting a single black pixel
to white when it is completely surrounded by white pixels or by
converting a single white pixel to black when it is completely
surrounded by black pixels.

» Majority Rule: sets each pixel based on its surrounding pixels. The
pixel will become white if the majority of the surrounding pixels are
white and vise versa.

Streak Filter — allows you to configure the scanner to filter vertical
streaks from your images. Streaks are lines which may appear on an
image and are not part of the original document. Streaks may be
caused by contaminants on your documents (e.g., dirt, dust or frayed
edges) or by not following the recommended cleaning procedures for
your scanner. Adjust the extent at which the streaks are filtered by
moving the slider bar from -2 to 2. The default is 0.
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Auto Color Detect tab The Auto Color Detect tab provides the following options:

x
Preset: |IDefauti2]
~Image Made Ac!iustments I Image Edge Fill I Blank Image Detection | About I
INormaI j I ain I Layout I Image Processing Auto Color Detect | Dropaout
Camera: Color Content
Front Image #1 =
[ Front Image #2 ID” J
O Eack Image #1 - Caolor Amount ————————— 7 [~ Calor Threshold ———
(Wt - -
.J—. 4?_'I J— I 50_‘!
1 200 ] 100
~ Leamn
Uze the leam mode to determine the proper ;I
Color Amount for detecting vour color
documents. Set the Color Threshold value
and click the Learn button to begin.

Toggle Pateh: e | Amournt Detected: 0
off |

Threshold Detected: O

Copy | QK I Cancel Help Drefault

Color Content
« Off: this is the default. No color content will be detected.

» Low: documents requiring only a small amount of color to be saved
as color or grayscale images. Used for capturing documents that are
primarily black text with small logos, or contain small amounts of
highlighted text or small colorful photos.

* Medium: documents require more color, as compared with the Low
option, before they are saved as color or grayscale images.

» High: documents require more color, as compared with the Medium
option, before they will be saved as color or grayscale images. Used
for distinguishing documents containing medium- to large-size
colorful photos from plain black text. Photos with neutral colors may
require adjustments to the Color Threshold or Color Amount values in
order to be captured correctly.
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» Custom: allows you to manually adjust the Color Amount and/or
Color Threshold.

NOTE: When setting Auto Color Detect values, it is suggested that
you start with the Medium option and scan a typical job set. If
too many documents were returned as color/grayscale vs.
black and white, then change to the High option and re-run
the job. If too few documents were returned as color/
grayscale vs. black and white, then change to the Low option
and re-run the job. If none of these options provide the
desired result, select Custom option to manually adjust Color
Amount and/or Color Threshold.

Color Amount: the amount of color that needs to be presentin a
document before it will be saved as either color or grayscale. As the
value of Color Amount increases, more color pixels are required. Valid
values are 1 to 200.

Color Threshold: the color threshold or intensity (i.e., pale blue vs.
dark blue) at which a given color will be included in the color amount
calculation. A higher value indicates that a more intense color is
required. Valid values are 0 to 100.

Learn — allows you to calculate your settings based on representative
color documents scanned. Before selecting Learn, place at least 5
representative color documents in the input elevator. The documents
will be scanned and analyzed to determine the recommended Color
Amount.

NOTE: The Color Amount and Color Threshold sliders will be
updated automatically. If these values do not provide the
desired results with your job set, you may need to manually
adjust the Color Threshold.
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Dropout tab The Dropout tab provides the following options:

Propetrties for KODAK i4200 on None ﬂ
Preset: |iDetauiti2]
~Image Made Adjustments I Image Edge Fill I Blank Image Detection [.)About t |
i i Topoul

INormaI j M ain I Layout I Image Processing I Auto Color Detect P
Camera: Color Dropout

Front Image #1 Lalor:

[ Front Image #2 None -

|| EBack Image #1
O Back Image #2

Mode:
Black and White

Grayzcale

Caolar

Auto Detect Grapscale
Auto Detect Color

Toggle Patch:

oif |

Copy | QK I Cancel | Help | Drefault |

Color Dropout — used to eliminate a form's background so that only
the entered data is included in the electronic image (i.e., remove the
form’s lines and boxes). For black and white images, these settings
effect the grayscale version of the document which the scanner
analyzes to produce that electronic image.

» Color: select the desired dropout color.
- None
- Red
- Green
- Blue

» Background Value: the amount of color that needs to be presentin a
document before it will be saved as either color/grayscale. As the
value of Background Value increases, more color pixels are required.

» Threshold Value: the color threshold or saturation (i.e., pale blue vs.
dark blue) at which a given color will be included in the color amount
calculation. A higher value indicates that a more intense color is
required.

Data on the form is color — allows you to indicate that a color other
than black or dark blue ink, was used for the data entered on the form.

L eEEEEEE©©EE—©E—©————————————————©————————————©©——©———©————©—————©———©——©————————©——©—————©——————©—————©——©———©——©————©——©©——©©©—©———————]
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Adjustments tab The Adjustments tab provides the following options:

x
Frezet: |[Default][2]
=l iads I ain | Layout I Image Processing I Auto Color Detect I Dropout I
INDrmaI j Adjustments | Image E dge Fill I Blank Image Detection I About
Camera: i~ Color Adjustment
W] Front Image #1 . . I 3
|:| Frant Image #2 Bl .JT 05
|| B ack Image #1 Contrast: —_— |— IU 3:
DBackImage #2 - 000 o
Bed: e J— ID 33
Green: —_— |— IU 3:
Mode: [T -
Black and white Hhe J b =
Grayscale '
-50 50
Auta Detect Grayzcale
Auta Detect Colar Sharpen: H <
i~ Background Smoothing
B ackground: I Mone j
Toggle Patch: Apply o IPredom\nant j
0ff j AOaessiveness: J— IU _IZ
-0 10

Copy | QK I Cancel | Help | Drefault |

For Black and White, Grayscale or Auto Detect Grayscale mode
Brightness — changes the amount of white in the color or grayscale
image. The values range from -50 to 50.

Contrast — makes the images sharper or softer. The values range
from -50 to 50.

For Color or Auto Detect Color mode

Adjust the following settings by dragging the slider bar to the left or
right, entering a value in the text box or using the up/down arrows.

* Red — changes the amount of red in the color image.
e Green — changes the amount of green in the color image.
* Blue — changes the amount of blue in the color image.

Background Smoothing — using this option for documents or forms
with a background color will help produce images with a more uniform
background color.

» Background: select one of the following:
- None - no background smoothing will be performed.
- Automatic - smooths up to three background colors.

- Change to White - identifies up to three background colors and
substitutes each color with white. If you select this option, the Apply
to option will be available.
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» Apply to:

- Predominant - smooths the predominant background color to
white.

- Neutral - smooths only the neutral color to white, and also smooths
up to two additional background colors.

- All - smooths the neutral color and up to two additional background
colors to white.

Sharpening — allows you to adjust the extent at which the
background(s) is determined. The values range from 0 to 3.
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Image Edge Fill tab This option fills the edges of the final electronic image by covering the
area with the specified color. Image Edge Fill is performed after all other
image processing options have been applied.

x
Preset: |iDetauiti2]
~Image Made Mai.n I Layout | | Inéadge E.ruocessing I Auto Color De.tec:t I Drropout I

INormaI j Adjustments mage Edge Fi | Blank Image Detection I About
Camera: r~Image Edge Fill

Front Image #1 Fill Colar:

[ Front Image #2 -

(W Back Image #1 I\’\"Ih'te j

[ Back Image 2 " Frame Mode

Left: IU.DD in

Mode: - I i

— Right: 0.00in

Black and ‘white

Grayzcale Top: IU_UU i

Auto Detect Grayscale ) l—

Auto Detect Color Eottom: 0.00in
Toggle Patch:

oif |

Copy | QK I Cancel | Help | Drefault |

Fill Color — allows you to select the color to fill the edges with.
* None
* White
» Black

Frame Mode — fills in an equal amount of the selected color from the
Image Edge Fill drop-down list on all sides of the image, or you can
select a value in the Top, Left, Right and/or Bottom area(s) from each
side of the scanned image to be filled.

NOTE: When using Image Edge Fill, be careful not to enter a value too
large as it could fill in image data that you want to keep.
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Blank Page Detection tab

Blank Image Detection allows you to configure the scanner to not give
blank images to the scanning application. Select the image size (KB),
below which an image is determined to be blank. Images with sizes less
than the number you select will not be created. If you use this option,
you must specify a blank image size for each image type (Black and
White, Grayscale and Color) you want to delete. If you do not make an
entry in these fields, all images are kept.

x
Preset: |iDetauiti2]
~Image Made Mai.n I Layout I Image F'.roc:essing B|I k.;ﬂuto E;Io{ D?tect | Drropout I
INormaI j Adjustments I Image Edge Fill lank Image Uetechion | About
Camera: i~ Blank Image Detection
Front Image #1 Mode
[ Front Image #2 IEontent j
|| EBack Image #1
[ Back Image #2 I™ Black and'white
= 3
I|—I 1% =
MBTdel; T [ Gragseale
lack an ite:
Grayscale |— I-I B _:Ii
Auto Detect Grapscale
Auto Detect Colar ' Color
o B
1% 100 %
Toggle Patch: i~ Learn Content
off A
J Uze the learn mode to determine Image content Amount.
Leam | Content: 0%
Copy | QK I Cancel Help Drefault
Mode

» Off: all images are given to the scanning application.

» Size: images will be considered blank based on the size of the image
that would be given to the scanning application (i.e., after all other
settings have been applied).

» Content: images will be considered blank based on the document
content within the image. Select Black and White, Grayscale or
Color to choose the maximum amount of content that the scanner
will consider to be blank. Any image that has more content than this
value will be considered non-blank and will be given to the scanning
application. The values range from 0 to 100 percent.

Learn Content — allows the scanner to determine the content amount

based on the documents to be scanned. Click Learn to use this

function.

NOTE: Learn mode cannot be applied to both the front and back sides
simultaneously. You must select the side you want to configure.
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About tab The About tab displays information about your scanner and driver.

Properties for KODAK i4200 on None ZI
FPreset: I[Default][2]
~ Image Mode tain | Layout | Image Processing I Auta Color Detect | Dropout |

-I Narmal j Adjustments | Image Edge Fill | Blark Image Detection Abaout
(LeEr) This driver was written to be
Front Image #1 compatible with 1SIS[R] but
[ Front Image #2 hag not been certified by EMC
O Corporation.
[ Back Image #2

eki4200 Yersion 1.1.11009.24002
KODAK 4000 Series Scanner

Mode: @ 2009 EMC Corporation. All rights reserved.
Black and ‘white GluickDriver Version 1.0.10917 5002
[Grayscale

Device Information:

Auta Detect Grayscale
Avto Detect Color

Toggle Patch:

|ort =l

EMLC, Captiva and 1515 are either registered trademarks or
trademarks of EMC Corporation in the United States and/or
other countries. QuickDriveris a rademark of EMC
Corparation. All other trademarks used herein are the property
of their respective owners.

@ Copyright 2003 EMC Corporation. Al rights reserved.

Copy | ok I Cancel Help Default

Configuring Scanner  To access scanner settings from the ISIS Driver, go into the Scan

settings Validation tool as described earlier in this guide and access the ISIS
driver.

KODAK i4200 on Mone

— Preset Configuration:
| |2
Frezet Mame:

| Lrefault

Degcription:
Default settings. d
I
— Propertie:
Image... Scanner. .. |

ak I Cancel |

» Click Scanner to configure settings associated with the scanner. The
following sections provide descriptions and procedures for
configuring Scanner settings. See the section entitled, “Configuring

Image settings” earlier in this guide for image configuration
procedures.
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Scanner tab The Scanner tab provides the following options:

zl
Preset: [iDefaitiiz)
Scanner | Multfeed Detection | Imprinter | Log | About |
r~ Document Feeder
Paper Source:
JanF =
Feeder Position
¥ Automatically start bansport
Sheet Counter IU
i~ Timeout
[ On
1 =
- 1 |5 _l;
| . . |

1 120 =econds
FResponse:
IStop Scanning j
‘white Background: I Mone - l
Stacker: I Mormal j
W awirnurn Lergth: |1 7
Power 5aver: |15 'l
Power Off: 50 -

Ok | Cancel | Hep |  Defau

Document Feeder

Paper Source

» ADF: the input elevator is in the highest position. This selection is
recommended when you are scanning 25 sheets or less from the
input elevator.

* Flatbed: scanner will scan from the flatbed.
Feeder Position

* Normal: looks for paper in the document feeder first. If there are no
documents in the input tray, the scanner will scan from the flatbed.

» 100 Sheets: looks for paper in the input elevator first, if there are no
documents in the input elevator, the scanner will scan from the
flatbed. This selection is recommended when you are scanning
between 25 and 100 sheets from the input elevator.

» 250 Sheets: looks for paper in the input elevator first, if there are no
documents in the input elevator, the scanner will scan from the
flatbed. This selection is recommended when you are scanning
between 100 and 250 sheets from the input elevator.

* 500 Sheets: looks for paper in the input elevator first, if there are no
documents in the input elevator, the scanner will scan from the
flatbed. This selection is recommended when you are scanning
between 250 and 500 sheets from the input elevator.

Automatic Start Transport — if selected, the scanner will wait for up
to 10 seconds for documents to be placed in the input elevator before
scanning will begin.
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Timeout — allows you to set the amount of time the scanner will wait
after the last document enters the transport before the transport timeout
action is taken. You can specify a time delay setting from 1 to 300
seconds.

Response — indicates the action that will be taken when the document
feeder timeout has been reached.

e Stop Scanning: scanning will stop and control will return to the
scanning application (i.e., ends the job).

» Pause Scanning: scanning will stop but the scanning application will
be waiting for additional images (i.e., stops the feeder). Scanning
may be resumed by pressing the Start/Resume button on the
scanner. Scanning may be stopped by pressing the Stop/Pause
button on the scanner or via the scanning application.

White Background — indicates which side(s) of the document will see
White instead of Black where there is no paper.

* (none): uses the Black background for the front and back sides.

» Front: only uses the White background for the front side, the back
side will use Black.

» Back only uses the White background for the back side, the front
side will use Black.

» Both: uses the White background for the front and back sides.
The following are examples of when white background is used:

» Scanning non-rectangular documents and, in the final image, you
want the area outside the document to be White instead of Black.

» Scanning lightweight or thin paper, with printing on one side, and you
do not want the black background to bleed through the document and
appear in the final image.

Stacker — allows you to select how the scanner transports documents
through the scanner. This affects how the documents are fed into the
scanner, how fast they move through the scanner, and how they are
placed in the output tray.

* Normal: no additional handling is performed. Best used when all
documents are similar in size.

* Improved Stacking: aids in controlling how the documents are
stacked/ordered in the output tray for mixed document sets. This
should work for the majority of mixed sets.

» Best Stacking: when your document set contains a great variability
in size, this option provides the best control of how the documents
are stacked/ordered within the output tray.
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Maximum Length — enter a value that indicates the length of the
longest document in your document set.

NOTES:

» Changing this value will affect the maximums for the following
settings: Area - Width; Height; Printer - Offset From Lead Edge;
Multifeed - Length Detection.

* Not all combinations of settings are supported at the larger lengths
(i.e, resolution, color, grayscale, etc.). To allow for greater flexibility
with applications, the scanner will not generate an error until it sees a
document whose length is not supported.

» The scanner’s throughput may be reduced for larger lengths.

Power Saver — allows you to set the amount of time (0 to 60 minutes)
the scanner will remain inactive before the scanner goes into an idle
state. The default is 15 minutes.

Power Off — allows you to set the amount of time, in minutes, the
scanner has to be in power saver mode before it automatically turns off.
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Multifeed Detection tab Multifeed detection aids in document processing by detecting
documents that may go through the feeder overlapped. Multifeed can
happen due to stapled documents, adhesives on documents or
electrostatically charged documents. The Multifeed Detection tab
provides the following options:

Properties for KODAK i4200 on None 5'

Preset: I[D efault][2]

Scanner  Multifeed Detection | Imprinterl Log I About I

r~ Multi-Feed Detection
¥ Length Detection

I ax Length:

|11.DD in

[~ Auta Set

Sengitivity: Low b

"Active Sensorg

Action:

IStop Scanning ﬂ @5

— O perations

LCalibrate... |

ak. I Cancel | Help | [ efault |

Length Detection — when you enable Length Detection you can
select the maximum length of the document that can be scanned
without a multifeed being detected. Length detection is used when
scanning same-sized documents to check for overlap. For example, if
you are scanning A4 (8.5 x 11-inch) documents in portrait mode, enter a
value of 28.57 cm (11.25 inches) in the Max Length field. The maximum
value is 35.56 cm (13.99 inches).

* Auto Set: automatically sets the maximum length value t01.27 cm
(.50-inch) greater than the length of the currently selected page size.

Ultrasonic Detection — check this option to set multifeed detection.

» Sensitivity — controls how aggressively the scanner will work to
determine if more than one document is fed into the transport.
Multifeeds are triggered by detecting air gaps between documents.
This allows multifeed detection to be used with job sets containing
documents with mixed thicknesses.

- Low: the least aggressive setting and is less likely to detect
labels, poor quality, thick or wrinkled documents as multifed
documents.
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- Medium: use Medium sensitivity if your application has varying
document thickness or labels attached to the document.
Depending on the label material, most documents with labels
should not be detected as a multifed document.

- High: the most aggressive setting. This is a good setting to use if
all documents are similar in thickness to 75.2 g/m2 (20-Ib.) Bond
paper.

Active Sensors — three sensors cover the width of the paper path. In

order for multifed documents to be detected correctly, they must pass
under one of these sensors.

» Left, Center, Right: this allows you to select which sensor(s) you
want to have turned on. For example, if you know that the left side of
the document has a “sticky” note on it, you can turn off the left sensor.

» Action — select what action you want the scanner to take when a
multifeed is detected. With all options, the condition will be logged in
the scanner.

- Stop Scanning: scanning will stop and control will return to the
scanning application (i.e., ends the job). Verify that the paper path
has been cleared and restart the scan session from the scanning
application.

- Stop Scanning - leave paper in path: scanning will stop
immediately (i.e., making no attempt to clear the paper path) and
control will return to the scanning application (i.e., ends the job).
Clear any documents from the paper path prior to restarting the
scan session from the scanning application.

- Continue Scanning: the scanner will continue to scan.

- Pause Scanning: scanning will stop but the scanning application
will be waiting for additional images (i.e., stops the feeder).
Scanning may be resumed by pressing the Start/Resume button
on the scanner. Scanning may be stopped by pressing the Stop/
Pause button on the scanner or via the scanning application.

- Pause Scanning - leave paper in path: scanning will stop
immediately (i.e., making no attempt to clear the paper path) but
the scanning application will be waiting for additional images (i.e.,
stops the feeder). Clear any documents from the paper path prior
to resuming the scan session. Scanning may be resumed by
pressing the Start/Resume button on the scanner. Scanning may
be stopped by pressing the Stop/Pause button on the scanner or
via the scanning application.

Alarm Volume — select Low, Medium or High if you want the scanner
to make a sound when a multifeed is detected.

NOTE: Clicking the Speaker icon will display the Open dialog box
allowing you to select the desired tone (.wav file) for your alarm.

Calibrate — displays the Calibration window allowing you to perform
an Image Chain or UDDS calibration.

NOTE: Frequent calibration is not necessary or recommended. Only
perform a calibration when instructed to do so by your support
personnel.
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Imprinter tab The Enhanced Printer operates at full scanner speed. The printer can
add a date, time, document sequential counter, and custom messages.

The print string can be configured to include both literal (static)
information (i.e., information that stays the same for each document,
such as batch name or operator) and dynamic information (i.e.,
information that may change for each page scanned, such as the
document sequential counter). The capture software application
controls static fields; any information that the software allows you to
enter can be sent to the printer.

Properties for KODAK i4200 on None il

Preset: I[D efault][2]

Scannerl Multifeed Detection  Imprinker I Log I About I

v On
Format Template: Top Margin:
| @9 |05
—Date Units:
Format: Delimiter: I Inches j
MDDy | Mane x| | Fank
I Mormal j
— Counter Botation
Field width:  ER= I =]
Farmat:
IDispIay Leading Zeros ﬂ H

E xamnple:

ak. I Cancel | Help | Drefault

On — check this to enable the printer.

Format Template — the format template is used to build the print
string. The print string is what is printed on documents as they travel
through the transport. The print string is printed before the document is
scanned, therefore, it is part of the image. The maximum amount of
characters for each print string is 40 characters (including spaces).

Date — if you want to add a date to the print string, select one of the
following formats:

* Format: MMDDYYYY, DDMMYYYY, or YYYYMMDD.

» Delimiter: select one of the following separators: Slash: /,
Dash: -, Dot: ., Space or none. For example: 08/24/2010,
08-24-2010, 08.24.2010 or 08 24 2010 or 08242010 (none).
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Counter — if you want to add a Counter to the print string, you can
enter one of the following options:

* Field Width: used to control the width of the document counter.
Values range from 1 to 9.

» Format — allows you to configure the format of the counter when the
width of the value is less than the field width (the examples indicate a
field width of 3 and the counter at 4). Options are:

- Display Leading Zeros (default): “004”
- Suppress Leading Zeros: “4”
- Compress Leading Zeros: * 4

Top Margin — allows you to define the distance from the lead edge
before the print string begins. Enter the desired amount in the text box.

NOTE: Printing automatically stops 6.3 mm (1/4-inch) from the trailing
edge of the document even if the information has not been
completely printed.

Units — select Inches, Centimeters or Pixels.

* Font — you can select what orientation you want your information to
be printed.

- Style: available character styles: Normal, Large and Bold.

e Lt )
e A% aE
M ™ ™

Normal: 90° rotation Large: 90° rotation Bold: 90° rotation

Rotation — you can select either 0 or 90 degrees.

28

A-61654/I1SIS August 2013



Logs tab The Logs tab provides a listing of any errors that have been
encountered.

Properties for KDDAK i4200 on None EI

Freset: |[D efault][2]

Scannerl Multifeed Detectionl Imprinter  Log |Ab0ut |

KODAE 14200 on Hone

ak | Cancel | Help | Default |

You can view the Operator and Meter logs and save this information to
a file by clicking the Save icon, or copy the information to the clipboard
which can then be pasted into a document.
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